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Overview

In the last decade, personal computer users have come to depend on their ma-

chines for a variety of tasks, nearly all of which culminate in the creation of docu-

ments. These can range from one-page spreadsheets or simple letters to charts, 

graphs, illustrations and photographic images, to more complex creations, such as 

newsletters or reports, that combine all of these elements.

The computer has traditionally been a tool for building or authoring these docu-

ments, then printing them onto paper for distribution to their intended audiences. 

Despite much industry discussion of the paperless office, computers have not been 

able to effectively communicate the digital documents they create.

Much of the difficulty for computer users in sharing computer-originated documents 

stems from the mix of computing platforms, configurations and applications found 

in most of todays offices. Incompatibility between hardware platforms, operating 

systems and application software has made sharing all but the most rudimentary 

documents impossible. When it can be shared across these barriers, text must be 

exchanged only in character-based ASCII format, which robs it of any distinctive 

typefaces or formatting and precludes the use of any color or graphic elements.

Adobe Systems Incorporated, developer of software technology for creating, dis-

playing and printing digital documents, is overcoming these barriers with a new ap-

proach to document communication. The Adobe Acrobat product family allows 

users to send documents created on their computer to other computers, regardless 

of hardware platform, operating system or application software used to create the 
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original. The document can be read, annotated, printed and stored by the receiving 

computer. Adobe Acrobat products preserve the documents essential look and 

feel, and provide tools to aid the receiver in navigating through its pages on-screen.

Adobe Acrobat products will eliminate the need to distribute many documents in 

paper form and makes possible, for the first time, effective universal electronic doc-

ument communication. Computer users can distribute fully formatted documents 

containing distinctive typefaces, color, graphics and photographs in electronic 

form. Recipients can work in one of two ways: as part of simple document distribu-

tion, in which recipients navigate, view and print documents; or document ex-

change, in which recipients navigate, view, print and annotate documents from 

others, and originate documents for transmission. This capacity for instantaneous 

communication of documents between computer users will be applicable to a 

broad range of business and consumer uses.

Adobe Acrobat Products

Adobe Acrobat software is a family of products that work together to enable docu-

ment communication. The key individual products include:

Acrobat Reader   a software application that addresses the needs of information 

consumers. It enables users to navigate, view and print documents represented in 

a special cross-platform file format, the Portable Document Format (PDF). Acrobat 

Reader software will be available for Macintosh
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, Windows

 



 

, DOS and UNIX

 



 

 

platforms.

Acrobat Exchange  a software application that addresses the needs of document 

exchangers. It enables users to view, navigate, annotate and print PDF files. PDF 

Writer will be included in this product to enable the creation and transmission of 

PDF files, whether original documents or combinations of existing PDF documents. 

Acrobat Exchange software will be available for Macintosh, Windows, DOS and 

UNIX platforms.



 

Acrobat PDF Writer  a specially designed printer driver that produces PDF files 

from applications. PDF Writers will come with Acrobat Exchange versions for Mac-

intosh and Windows, the environments where such a driver will be the primary 

means of producing files in the Acrobat PDF.

Acrobat Distiller
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  a software program that translates PostScript
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 language files 

into PDF. Acrobat Distiller software will be available for Macintosh, Windows and 

UNIX platforms.

Following is a description of the technical components of Acrobat products and 

how they work together to enable universal document communication.

The Technology Behind Adobe Acrobat : The Portable Document Format (PDF)

The key to the cross-platform functionality of Adobe Acrobat products is a unique 

PostScript language-based file format called the Portable Document Format, or 

PDF. A PDF file can describe documents containing any combination of text, 

graphics and images in a device- and resolution-independent format. These docu-

ments can be one page or thousands of pages, very simple or extremely complex 

with rich use of fonts, graphics, color and images.

PDF, which Adobe will document and publish for use by software developers as an 

open standard, is designed to replicate the appearance of pages with the same 

high fidelity as PostScript software. But a PDF file uses the PostScript language to 

describe not only the visual (printable) aspects of a document, but also additional 

document elements such as annotations (notes), hypertext links, miniature thumb-

nail views of pages, and bookmarks. 

Like the PostScript language, PDF files are both device- and resolution-indepen-

dent. They appear on a computer display at the screens highest possible resolu-

tion, regardless of the hardware design or manufacturer. Because it is device- 

independent, PDF represents information about a pages appearance in a manner 

that can be rendered by all major computers, display screens or output devices  an 
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essential capability in todays world of multiplatform computing environments.

Creating PDF Files

Because the Portable Document Format is hardware platform, operating system 

and application neutral, virtually any document on any platform from any applica-

tion can be converted into a PDF file. 

A PDF file can be created from any application program that prints. The file may 

start as a word processing document, illustration from a drawing program, or a 

worksheet or graph from a spreadsheet program. Combinations of these elements 

created using cut and paste system utilities or through more advanced importation 

into page-layout applications can also readily be turned into PDF files, or can be 

clipped together in Adobe Acrobat itself. 

The conversion from the document produced by the application into a PDF file is 

accomplished in one of two ways  either by using the specially designed printer 

driver, called the Acrobat PDF Writer, or through the software translation program, 

called the Acrobat Distiller.

To produce a PDF file using the PDF Writer, the user simply proceeds as if to print 

the document. In a special print dialog, the user is presented with the option of cre-

ating a PDF file. The PDF Writers is designed to translate most files created on 

PCs running Windows and on Macintosh computers. The PDF Writer essentially 

converts GDI (for Windows) or QuickDraw
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 (for Macintosh) document descriptions 

into PDF descriptions and uses the standard system-level printing interfaces to 

communicate with applications.

Acrobat Distiller software translates PostScript language files into PDF files. It is 

designed to create PDF files from computing environments such as UNIX and 

DOS, where printer drivers do not exist. In addition, Acrobat Distiller helps users 

create PDF files from documents that contain placed Encapsulated PostScript 

(EPS) artwork or images, as well as from documents created in applications that 



 

bypass system-level printing facilities and generate their own PostScript language 

files for printing. 

Small, Portable Files

The PDF is 7-bit ASCII (American Standard Code for Information Exchange), 

which means that it is extremely portable between diverse hardware and operating 

system environments. By international agreement, this standard is recognized by 

all computer hardware and software makers as a universal means of exchanging 

text information electronically.

While 7-bit ASCII formatting ensures the universality of PDF files, data compress-

sion makes them compact for speedy transmission and low demand on memory 

space. Compression algorithms such as LZW, RLE, CCITT Group 3 and 4, and 

JPEG are used to keep file sizes manageable. Compression of information within 

a PDF file will occur in the PDF Writer or Acrobat Distiller, and decompression will 

take place on the fly within Acrobat Reader or Acrobat Exchange software.

With JPEG, color and grayscale images can be compressed by a factor of 10:1 or 

more. The effective compression of monochrome images is highly dependent on 

the compression filter used and the properties of the image, but factors of 2:1 to 8:1 

are common. LZW compression of text and graphics comprising the balance of the 

document results in compression ratios of approximately 2:1.

For all but the most graphics-intensive documents, PDF files will be significantly 

smaller than the CCITT Group 3-compresssed counterparts used for facsimile. A 

200-dpi CCITT Group 3 file of 50 to 65K per page, for example, would require only 

5 to 10K per page as a PDF file, and would be capable of printing at 300-dpi or any 

other required resolution. The reduction in file size translates into shorter transmis-

sion times across networks and phone lines and less demand for memory space. 

In addition, traditional document imaging systems that represent document pages 

as Group 4 images are limited by fixed resolution, no color, no ability to search for 

content, and limited portability.
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The universality of PDF and the effectiveness of its compression scheme allow 

PDF files to be communicated by a variety of means  over LAN networks, on CD-

ROM or magnetic diskette, or over telecommunications networks or other electron-

ic highways. Before Adobes PDF, the only universal language available for this 

type of cross-platform communication was ASCII text. PDF provides the first uni-

versal alternative to ASCII, and the only reliable means for conveying information 

about graphics and photographs between platforms.

With PDF, authors or publishers can create documents in a single format, then 

send them to computer users on many platforms. These documents can be viewed 

or printed by any computer equipped with Acrobat Reader or Acrobat Exchange 

software. This eliminates the need to publish documents in formats specific to each 

intended readers computer system. 

Acrobat Exchange Software

While Acrobat Reader enables document recipients to navigate, view and print 

pages, Acrobat Exchange software lets them view incoming PDF files, as well as 

navigate, annotate and print the documents. Its graphical interface provides clear, 

intuitive access to all of its functions. 

Acrobat Exchange includes navigational tools that can pan, scroll and zoom, and 

allow the user to access different portions of a document using miniature thumbnail 

representations of each page. The thumbnails appear in the margin of the main 

window and are visible independently from the document open on-screen. The 

user can leaf through the thumbnails as if they were bound in a magazine, then 

jump from the page on-screen to a distant page by mouse-clicking the thumbnail 

for the destination page.

Acrobat Exchange also has a live links feature that enables users to create links in 

PDF files. These are ideal for cross-referencing within a document.



 

Acrobat Exchange software even allows the reader to annotate PDF files by affix-

ing electronic sticky notes to them. These notes are transmitted along with the main 

PDF file, and may be hidden or displayed at the readers discretion.

Acrobat Exchange software includes the PDF Writer printer driver to enable docu-

ment creation and transmission. 

Acrobat Font Substitution

A key component of Adobe Acrobat software is a font substitution capability that 

solves one of the fundamental barriers to document communication,the font prob-

lem. In current systems, if a computer lacks a font in a document received, the user 

may not be able to view or print the document, or the computer may substitute a 

different font for the absent one, drastically altering the documents appearance or 

making it completely illegible.

Adobe Acrobat products use Adobes multiple master font technology to solve the 

font problem in document communication. Multiple master fonts were developed 

by Adobe as an extension to Adobes Type 1 font format. They can allow users to 

control weight, width, size and style of type across a broad adjustable range. 

PDF files carry the metrics and other information about the fonts used in a docu-

ment, without actually including the font. The PDF file contains information about 

the weight, width, size and style of the typefaces in the document, as well as the 

names of the specific fonts. When the receiver of a PDF file lacks a typeface in a 

document, Acrobat font substitution reads the metrics and simulates the absent 

fonts with a special Adobe multiple master typeface. The appearance of the un-

available font is approximated so closely that, even if the recipient has none of the 

fonts in the original document, the relative size, boldness and style of type on the 

page is retained, preserving the look and feel of text on the page.

Acrobat software uses two special multiple master fonts, a serif and a sans serif 

design, developed with a wide dynamic range to effectively simulate a vast number 
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and variety of text typefaces.

Acrobat Publishers Tools

In the future, a set of tools for corporate and commercial publishers will provide a 

means for creating new PDF documents with a variety of enhanced functions. Pub-

lishers will use these tools to add value to PDF versions of their publications, which 

could be distributed on-line or on CD-ROM with versions of Acrobat Reader soft-

ware. The Acrobat publishers tools will enable automatic live-linked indexes for 

documents, allowing the reader to locate any passage instantly by clicking on its 

entry in the index. The tools also will accommodate popular search engine soft-

ware. It enables the user to locate any word or entry in a document instantly, or 

even cross-reference different subjects within a document or set of documents.

Another possibility is the creation of deep advertisements within electronic docu-

ments. An interested reader, for example, could click on a photo of an advertised 

product and gain access to more detailed information about it, such as perfor-

mance specifications or a list of local dealers.

In addition, Adobe Acrobat products will provide support for representing document 

structure such as standard generalized markup language (SGML), and different 

applications file structures.

Markets for Adobe Acrobat Products

The ability to send and receive fully formatted electronic documents immediately 

lends itself to two uses: personal and mass communication. To fully realize its long-

term potential, any significant document communication strategy must fulfill the re-

quirements of both markets today.

Personal Communication

Communication is a primary area of immediate use for Adobe Acrobat products. In 

this context, communication may be defined as enabling a group of computer users 

to create and send an electronic document to other members of the group, even if 



 

their computer system and applications are different.

Communication roles for Adobe Acrobat products can be characterized as server-

based or telecommunications-based. Server-based applications involve the com-

munication of computer files in PDF across networks. The technology functions 

equally well within local-area networks (LANs), like those that might link computers 

within an office, and wide-area networks (WANs), like those that might connect co-

workers across a campus of several buildings or branch offices across the country. 

Telecommunications-based document communication enables electronic docu-

ments to be sent across telephone lines by modem. This is useful for communicat-

ing information between distant offices and is also ideal for traveling executives 

who use portable computers.

For business users, documents in Adobes PDF can replace much of the paper cor-

respondence that litters office desktops. The result will be greater convenience and 

significant cost reductions. Adobe Acrobat products will cut expenses associated 

with printing and photocopying documents, conveying them from sender to recipi-

ent, and filing and tracking them for future use. It will also reduce expenses  of both 

money and time  associated with moving paper documents from centralized corpo-

rate publishing sites to their target readers. Adobe Acrobat products will allow read-

ers to print just the pages they need on their own office printers, any time and in 

any quantity they desire.

Mass Communication

Electronic publishing, which may be defined as production and distribution of doc-

uments from a single source to many readers at remote sites, can itself be divided 

into two segments: commercial and corporate or business publishers. Commercial 

publishers make their profits directly from the sale of information and advertising in 

publications such as newspapers, magazines and books. Business publishers cre-

ate and distribute documents in the course of a separate business activity. Such 

documents include procedural manuals, technical documentation or user manuals, 

annual reports and marketing studies.



 

With the Adobe Acrobat family of products, both ventures may take advantage of 

publishing media that are more cost-effective than paper, including on-line, or serv-

er-based, transmission, CD-ROM, and any use of the existing electronic highways.

On-line, or server-based, electronic publishing involves direct transmission of doc-

uments over computer networks or telecommunications channels. The publisher 

might send documents to the reader across these channels, or the reader might 

access a server and order desired documents. 

CD-ROM electronic publishing entails the use of read-only optical compact discs 

as a publishing medium. The publisher distributes these discs to readers, who view 

them using a CD-ROM drive. CD-ROM is rapidly gaining popularity as a publishing 

vehicle because it offers impressive information storage capability and permits 

very quick access to information stored anywhere on the disc.

Adobe Acrobat software offers advantages to both on-line and CD-ROM publishers 

by enabling documents to be published in a format that can be read by any com-

puter user. For the first time, networked computers on different platforms will be 

able to easily communicate files that contain graphics, photographs and complex 

layouts. Acrobat software also eliminates the need to publish different CD-ROMs 

for every target computing system.

The Emerging Document Communication Field

The field of document communication is in its infancy, and recently a number of 

products and technologies have been announced that offer some capabilities of 

document communication. Some of them will compete with the Adobe Acrobat 

product offerings, while others will be complementary to them.

Many of the emerging technologies are more limited in scope than Adobe Acrobat 

products. Some are designed for multiplatform publishing, but not communication; 

others allow two-way exchange of documents, but are limited to specific platforms 



 

or applications. Adobe is committed to developing Adobe Acrobat products for uni-

versal document communication, offering full publishing and communication func-

tionality on all major platforms, operating systems and applications. 

As it evolves, document communication will mark a convergence of technical ad-

vancements in the areas of computer publishing, printing and information distribu-

tion, video and telecommunications. Because the PostScript language is already a 

standard in these areas, Adobe is well aware of their collective and individual 

needs.  This insight, as well as experience as an innovator in platform-independent 

software, places Adobe in a strong position to lead the way toward digital document 

communication of the future.

Future Technology Directions for Adobe Acrobat

As electronic document communication becomes a reality, the requirements of the 

technology and users needs will continue to grow and expand. Adobe is developing 

the next areas of advanced technologies that will be important for the extension of 

Adobe Acrobat products and the Portable Document Format. These include optical 

page recognition, the ability to communicate editable electronic documents, docu-

ment management, as well as the need to address the rapidly emerging areas of 

audio and video inclusion in digital documents.

For the last 10 years, Adobe Systems has been a pioneer in the development of 

technology for the creation, display and printing of electronic documents. Adobes 

knowledge of electronic documents and the people who use them have led the 

company to embrace document communication as the next logical step in its evo-

lution.

In the 1980s, Adobe anticipated the needs of office users with PostScript software 

technology that allowed them to create, display and print professional-quality doc-

uments. In the 1990s, with the introduction of Acrobat products, Adobe will take 

communication to the next phase of its evolution.
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About This Tour

 

This tour demonstrates the features of the Acrobat Exchange 
program. We recommend that you go through the tour from 
beginning to end. 

Click the Continue button at the end of each screen to 
continue the tour.

If you make a mistake, click the Go Back button to 
retrace your steps.

If you get lost, click the First Page button to return to the 
opening screen of the tour; then find your place in the 
following list of topics, and click the topic to return to 
that place in the tour.

 

•

 

Paging through a document

 

•

 

Scrolling

 

•

 

Zooming in and out

 

•

 

Using links

 

•

 

Adding notes

 

•

 

Finding words

 

•

 

Using bookmarks

 

•

 

Browsing with thumbnails



 

Paging through a document

 

The Acrobat Exchange program gives you a number of ways 
paging through a document:

 

•

 

Use the Next Page and Previous Page buttons in 
the tool bar (or the Next Page and Previous Page 
commands in the View menu).

 

•

 

Use the PageDown and PageUp keys to move one 

 

screen

 

 at a time. (If your Macintosh keyboard 
doesn’t have PageDown and PageUp keys, press 
Return for PageDown and Shift-Return for PageUp.)

 

•

 

Use the vertical scroll bar to jump to a specific 
page.

 

•

 

Click the page number box in the at the bottom of 
the Exchange window (or choose Go to Page from 
the View menu), and enter a page number in the Go 
To Page dialog box.

 

Continue
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Scrolling

 

When your current view of a document does not show the full 
height of the document page, you can use the vertical scroll bar 
to scroll up and down over the page. 

And when your current view of a document does not show the 
full width of the document page, you can use the horizontal 
scroll bar to scroll left and right over the page.

 

Continue
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Zooming in and out

 

Acrobat Exchange gives you many ways of zooming in and out 
on a page:

Use the zoom tools to double or halve the page 
view or to soom by dragging a marquee

Use the Zoom menu at the bottom of the screen to 
choose from a number of magnifications

Use the Zoom To command in the View menu to 
specify a magnification

Use the page view buttons to change the view a 
page at 100 percent, to scale the page to fit the win-
dow, or to scale the page to fit the page width in 
the window.

 

Continue
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Using Links

 

You can place any number of links in an Acrobat document. A 
link is a spot on one page that is linked to a view of another 
page.

You can use links for a variety of purposes. For example, you 
can link 

 

see

 

 and 

 

see also

 

 references to the pages they reference. 
You can also link table of contents and index entries to the pages 
they reference. And if you are creating a newsletter, you can 
link the bottom of continued articles to the column where the 
articles are continued.

This tour contains many links. Every time you click a Continue 
button, you are using a link.

 

Continue
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Using Bookmarks

 

You can add bookmarks to an Acrobat document to mark loca-
tions for later reference. If a document contains bookmarks, you 
can open the overview area of the Exchange window to show a 
scrolling list of bookmark names. With the overview area 
showing bookmarks, you can double-click any bookmark name 
to jump to the location marked with that name.

Click the Bookmark button in the tool bar to display 
bookmarks in the overview area; then double-click the 
page icon to the left of the bookmark name Adding 
Bookmarks.



 

Using Thumbnails

 

If a document contains thumbnails, you open the overview area 
of the Exchange window to show a scrolling list of thumbnail 
images of all the document pages. (A thumbnail is a miniature 
image of a page.) You can double-click any thumbnail to jump 
to the page represented by that thumbnail.

Click the Thumbnail button in the tool bar. 

The overview pane opens to show thumbnails of the 
pages in this tour.

 

1

 

 Use the scroll bar to the right of the overview area to 
scroll down until you see the thumbnail for page 28 (the 
spreadsheet).

 

2

 

 Double click the lower right corner of the thumbnail 
for page 28. The place you double-click on a thumbnail 
determines the part of the page that is displayed in the 
center of the screen.



 

Adding Notes

 

You can add notes to Acrobat documents. Acrobat notes are like 
the little yellow sticky notes that you can stick on document 
pages. Acrobat notes, however, have advantages over paper 
notes. For example, text scrolls in a text window and you can 
change the size of a note window. Another advantage is that 
Acrobat notes can be opened and closed. When closed, an 
Acrobat note is a note icon. Finally, Acrobat Exchange lets you 
jump from note to note within a document.

 

Continue
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Adding Bookmarks

 

You can add bookmarks to an Acrobat document to mark loca-
tions for later reference. Bookmarks can provide quick access to 
hard-to-find or often-used parts of a document. If you are 
preparing an Acrobat document for distribution, you can also 
use bookmarks to create an outline or table of contents for a 
document. Users can then use the bookmarks to quickly move 
from topic to topic within the document.

 

Continue
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A B C D E F G H I J K L M N O P Q
PRINCIPAL $100,000 PRINCIPAL $100,000 PRINCIPAL $150,000 PRINCIPAL $150,000 PRINCIPAL $203,150 PRINCIPAL $203,150
Term 30 Term 15 Term 30 Term 15 Term 30 Term 15

Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment
5.40% ($562) 5.40% ($812) 5.40% ($842) 5.40% ($1,218) 5.40% ($1,141) 5.40% ($1,649)
5.60% ($574) 5.60% ($861) 5.60% ($861) 5.60% ($1,234) 5.60% ($1,166) 5.60% ($1,671)
5.80% ($587) 5.80% ($880) 5.80% ($880) 5.80% ($1,250) 5.80% ($1,192) 5.80% ($1,692)
6.00% ($600) 6.00% ($899) 6.00% ($899) 6.00% ($1,266) 6.00% ($1,218) 6.00% ($1,714)
6.20% ($612) 6.20% ($919) 6.20% ($919) 6.20% ($1,282) 6.20% ($1,244) 6.20% ($1,736)
6.40% ($626) 6.40% ($938) 6.40% ($938) 6.40% ($1,298) 6.40% ($1,271) 6.40% ($1,759)
6.80% ($652) 6.80% ($978) 6.80% ($978) 6.80% ($1,332) 6.80% ($1,324) 6.80% ($1,803)
7.00% ($665) 7.00% ($998) 7.00% ($998) 7.00% ($1,348) 7.00% ($1,352) 7.00% ($1,826)
7.20% ($679) 7.20% ($1,018) 7.20% ($1,018) 7.20% ($1,365) 7.20% ($1,379) 7.20% ($1,849)
7.40% ($692) 7.40% ($1,039) 7.40% ($1,039) 7.40% ($1,382) 7.40% ($1,407) 7.40% ($1,872)
7.50% ($699) 7.50% ($1,049) 7.50% ($1,049) 7.50% ($1,391) 7.50% ($1,420) 7.50% ($1,883)
7.60% ($706) 7.60% ($1,059) 7.60% ($1,059) 7.60% ($1,399) 7.60% ($1,434) 7.60% ($1,895)
7.63% ($708) 7.63% ($1,062) 7.63% ($1,062) 7.63% ($1,401) 7.63% ($1,438) 7.63% ($1,898)
7.80% ($720) 7.80% ($1,080) 7.80% ($1,080) 7.80% ($1,416) 7.80% ($1,462) 7.80% ($1,918)
8.00% ($734) 8.00% ($1,101) 8.00% ($1,101) 8.00% ($1,433) 8.00% ($1,491) 8.00% ($1,941)
8.20% ($748) 8.20% ($1,122) 8.20% ($1,122) 8.20% ($1,451) 8.20% ($1,519) 8.20% ($1,965)
8.40% ($762) 8.40% ($1,143) 8.40% ($1,143) 8.40% ($1,468) 8.40% ($1,548) 8.40% ($1,989)
8.60% ($776) 8.60% ($1,164) 8.60% ($1,164) 8.60% ($1,486) 8.60% ($1,576) 8.60% ($2,012)
8.80% ($790) 8.80% ($1,185) 8.80% ($1,185) 8.80% ($1,504) 8.80% ($1,605) 8.80% ($2,036)
9.00% ($805) 9.00% ($1,207) 9.00% ($1,207) 9.00% ($1,521) 9.00% ($1,635) 9.00% ($2,060)
9.20% ($819) 9.20% ($1,229) 9.20% ($1,229) 9.20% ($1,539) 9.20% ($1,664) 9.20% ($2,085)
9.40% ($834) 9.40% ($1,250) 9.40% ($1,250) 9.40% ($1,557) 9.40% ($1,693) 9.40% ($2,109)
9.60% ($848) 9.60% ($1,272) 9.60% ($1,272) 9.60% ($1,575) 9.60% ($1,723) 9.60% ($2,134)
9.80% ($863) 9.80% ($1,294) 9.80% ($1,294) 9.80% ($1,594) 9.80% ($1,753) 9.80% ($2,158)

10.00% ($878) 10.00% ($1,316) 10.00% ($1,316) 10.00% ($1,612) 10.00% ($1,783) 10.00% ($2,183)
10.20% ($892) 10.20% ($1,339) 10.20% ($1,339) 10.20% ($1,630) 10.20% ($1,813) 10.20% ($2,208)
10.40% ($907) 10.40% ($1,361) 10.40% ($1,361) 10.40% ($1,649) 10.40% ($1,843) 10.40% ($2,233)
10.60% ($922) 10.60% ($1,383) 10.60% ($1,383) 10.60% ($1,667) 10.60% ($1,873) 10.60% ($2,258)
10.80% ($937) 10.80% ($1,406) 10.80% ($1,406) 10.80% ($1,686) 10.80% ($1,904) 10.80% ($2,284)
11.00% ($952) 11.00% ($1,428) 11.00% ($1,428) 11.00% ($1,705) 11.00% ($1,935) 11.00% ($2,309)
11.20% ($967) 11.20% ($1,451) 11.20% ($1,451) 11.20% ($1,724) 11.20% ($1,965) 11.20% ($2,335)
11.40% ($983) 11.40% ($1,474) 11.40% ($1,474) 11.40% ($1,743) 11.40% ($1,996) 11.40% ($2,360)
11.60% ($998) 11.60% ($1,497) 11.60% ($1,497) 11.60% ($1,762) 11.60% ($2,027) 11.60% ($2,386)
11.80% ($1,013) 11.80% ($1,520) 11.80% ($1,520) 11.80% ($1,781) 11.80% ($2,058) 11.80% ($2,412)
12.00% ($1,029) 12.00% ($1,543) 12.00% ($1,543) 12.00% ($1,800) 12.00% ($2,090) 12.00% ($2,438)
12.20% ($1,044) 12.20% ($1,566) 12.20% ($1,566) 12.20% ($1,820) 12.20% ($2,121) 12.20% ($2,464)
12.40% ($1,060) 12.40% ($1,589) 12.40% ($1,589) 12.40% ($1,839) 12.40% ($2,152) 12.40% ($2,491)
12.60% ($1,075) 12.60% ($1,613) 12.60% ($1,613) 12.60% ($1,859) 12.60% ($2,184) 12.60% ($2,517)
12.80% ($1,091) 12.80% ($1,636) 12.80% ($1,636) 12.80% ($1,878) 12.80% ($2,216) 12.80% ($2,544)
13.00% ($1,106) 13.00% ($1,659) 13.00% ($1,659) 13.00% ($1,898) 13.00% ($2,247) 13.00% ($2,570)
13.20% ($1,122) 13.20% ($1,683) 13.20% ($1,683) 13.20% ($1,918) 13.20% ($2,279) 13.20% ($2,597)
13.40% ($1,138) 13.40% ($1,706) 13.40% ($1,706) 13.40% ($1,938) 13.40% ($2,311) 13.40% ($2,624)
13.60% ($1,153) 13.60% ($1,730) 13.60% ($1,730) 13.60% ($1,957) 13.60% ($2,343) 13.60% ($2,651)
13.80% ($1,169) 13.80% ($1,754) 13.80% ($1,754) 13.80% ($1,977) 13.80% ($2,375) 13.80% ($2,678)
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This is the upper left corner of a large spread sheet




1  Place the pointer over the right scroll box

on the horizontal scroll bar, hold down the 

mouse button, and drag until the box reaches

the right edge of the scroll bar. 

This is the upper right corner of a large spread sheet.

You can also use the hand tool to scroll about a page.






2  Click the hand tool on the tool bar.

The mouse pointer changes to the hand tool.


3  Place the Hand tool at the very bottom of the 

window, hold the mouse button, and

drag the hand to the top of the window. 

This is the lower right corner of the large spread 

sheet



You can also scroll by dragging the scroll boxes in

the scroll bars.




4  Place the pointer over the scroll box in the 

horizontal scrollbar,  hold the mouse button 

and drag the button to the left edge of the 

horizontal scroll bar. 

This is the lower-left corner of the large spread 

sheet and the end of the Scrolling tour.



Continue . . . 
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LEVEL

TWO

This is an office map. The names and phone 

numbers are too small to read at this maginfication 

level. By zooming in you can read the names and

numbers.




1  Click the Zoom-In tool




2  Place the magnifying glass over the

desk in the lobby and click the mouse button.

Clicking the zoom-in tool doubled the 

magnification to 200%.  You can also use 

the Zoom In tool to draw a box of magnification



3  Position the zoom-in tool at the upper left 

corner of the dotted rectangle around the 

receptionist desk, hold down the mouse button, 

and drag down to the lower right corner of the 

dotted rectangle. Then release the mouse button 

to zoom in. 

Here is a magnified view of the 

Receptionist's desk.

 

4 Click this line to continue the zoom

tour.



      

profits

       ANNUAL   SALES   FIGURES
Per Year End of year End of year End of year

1992 1991 1990

Sales
Gross sales 134,000.56 125,000.65 110,895.45
less cost of goods sold 64,000.45 53,000.78 42,753.65
Net Sales 70,000.11 71,999.87 68,141.80

Expenses
Direct costs 4,100.00 4,300.00 4,200.00
Research and Development 2,200.00 1,900.00 2,150.00
Marketing Expenses 3,500.00 3,100.00 2,600.00
General Expenses 1,200.00 1,000.00 800.00
Administrative Expenses 1,000.00 1,100.00 1,200.00
Overhead 790.00 640.00 540.00
Total Expenses 12,790.00 12,040.00 11,490.00

Taxes  
Federal 54.60 46.70 43.60
Local 12.50 11.30 10.50
Total Taxes Expenditures 67.10 58.00 54.10

Profits per Year 57,143.01 59,901.87 56,597.70

Page 1

5  Click the Fit Page, Fit Width, and Actual 

Size buttons to see how they change

the page view







This completes the zoom tour.



Continue . . .
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This is the first page of an Acrobat phone list and

office map document. Each person's name is a link 

button that is linked to the location of the person's 

office in the map.





1  Click anywhere on Marvin Dolansky's name

to see where Marvin sits.  Marvins name is at the 

lower-right corner of this page.
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This is the office map shown at 200%.
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Gustavo

Velazquez


2609

The link shows a magnified view of Marvin's

office in  the officemap.



2  To see where Marvin's office is, place the

 pointer over the Zoom status box at the bottom of

the viewing window, press and hold 

the mouse button to show the Zoom menu, 

and choose 200%
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Home Loan pymt for rate
1
2
3
4
5
6
7
8
9

1 0
1 1
1 2
1 3
1 4
1 5
1 6
1 7
1 8
1 9
2 0
2 1
2 2
2 3
2 4
2 5
2 6
2 7
2 8
2 9
3 0
3 1
3 2
3 3
3 4
3 5
3 6
3 7
3 8
3 9
4 0
4 1
4 2
4 3
4 4
4 5
4 6
4 7
4 8

A B C D E F G H I J K L M N O P Q
PRINCIPAL $100,000 PRINCIPAL $100,000 PRINCIPAL $150,000 PRINCIPAL $150,000 PRINCIPAL $203,150 PRINCIPAL $203,150
Term 30 Term 15 Term 30 Term 15 Term 30 Term 15

Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment Rate Monthly Payment
5.40% ($562) 5.40% ($812) 5.40% ($842) 5.40% ($1,218) 5.40% ($1,141) 5.40% ($1,649)
5.60% ($574) 5.60% ($861) 5.60% ($861) 5.60% ($1,234) 5.60% ($1,166) 5.60% ($1,671)
5.80% ($587) 5.80% ($880) 5.80% ($880) 5.80% ($1,250) 5.80% ($1,192) 5.80% ($1,692)
6.00% ($600) 6.00% ($899) 6.00% ($899) 6.00% ($1,266) 6.00% ($1,218) 6.00% ($1,714)
6.20% ($612) 6.20% ($919) 6.20% ($919) 6.20% ($1,282) 6.20% ($1,244) 6.20% ($1,736)
6.40% ($626) 6.40% ($938) 6.40% ($938) 6.40% ($1,298) 6.40% ($1,271) 6.40% ($1,759)
6.80% ($652) 6.80% ($978) 6.80% ($978) 6.80% ($1,332) 6.80% ($1,324) 6.80% ($1,803)
7.00% ($665) 7.00% ($998) 7.00% ($998) 7.00% ($1,348) 7.00% ($1,352) 7.00% ($1,826)
7.20% ($679) 7.20% ($1,018) 7.20% ($1,018) 7.20% ($1,365) 7.20% ($1,379) 7.20% ($1,849)
7.40% ($692) 7.40% ($1,039) 7.40% ($1,039) 7.40% ($1,382) 7.40% ($1,407) 7.40% ($1,872)
7.50% ($699) 7.50% ($1,049) 7.50% ($1,049) 7.50% ($1,391) 7.50% ($1,420) 7.50% ($1,883)
7.60% ($706) 7.60% ($1,059) 7.60% ($1,059) 7.60% ($1,399) 7.60% ($1,434) 7.60% ($1,895)
7.63% ($708) 7.63% ($1,062) 7.63% ($1,062) 7.63% ($1,401) 7.63% ($1,438) 7.63% ($1,898)
7.80% ($720) 7.80% ($1,080) 7.80% ($1,080) 7.80% ($1,416) 7.80% ($1,462) 7.80% ($1,918)
8.00% ($734) 8.00% ($1,101) 8.00% ($1,101) 8.00% ($1,433) 8.00% ($1,491) 8.00% ($1,941)
8.20% ($748) 8.20% ($1,122) 8.20% ($1,122) 8.20% ($1,451) 8.20% ($1,519) 8.20% ($1,965)
8.40% ($762) 8.40% ($1,143) 8.40% ($1,143) 8.40% ($1,468) 8.40% ($1,548) 8.40% ($1,989)
8.60% ($776) 8.60% ($1,164) 8.60% ($1,164) 8.60% ($1,486) 8.60% ($1,576) 8.60% ($2,012)
8.80% ($790) 8.80% ($1,185) 8.80% ($1,185) 8.80% ($1,504) 8.80% ($1,605) 8.80% ($2,036)
9.00% ($805) 9.00% ($1,207) 9.00% ($1,207) 9.00% ($1,521) 9.00% ($1,635) 9.00% ($2,060)
9.20% ($819) 9.20% ($1,229) 9.20% ($1,229) 9.20% ($1,539) 9.20% ($1,664) 9.20% ($2,085)
9.40% ($834) 9.40% ($1,250) 9.40% ($1,250) 9.40% ($1,557) 9.40% ($1,693) 9.40% ($2,109)
9.60% ($848) 9.60% ($1,272) 9.60% ($1,272) 9.60% ($1,575) 9.60% ($1,723) 9.60% ($2,134)
9.80% ($863) 9.80% ($1,294) 9.80% ($1,294) 9.80% ($1,594) 9.80% ($1,753) 9.80% ($2,158)

10.00% ($878) 10.00% ($1,316) 10.00% ($1,316) 10.00% ($1,612) 10.00% ($1,783) 10.00% ($2,183)
10.20% ($892) 10.20% ($1,339) 10.20% ($1,339) 10.20% ($1,630) 10.20% ($1,813) 10.20% ($2,208)
10.40% ($907) 10.40% ($1,361) 10.40% ($1,361) 10.40% ($1,649) 10.40% ($1,843) 10.40% ($2,233)
10.60% ($922) 10.60% ($1,383) 10.60% ($1,383) 10.60% ($1,667) 10.60% ($1,873) 10.60% ($2,258)
10.80% ($937) 10.80% ($1,406) 10.80% ($1,406) 10.80% ($1,686) 10.80% ($1,904) 10.80% ($2,284)
11.00% ($952) 11.00% ($1,428) 11.00% ($1,428) 11.00% ($1,705) 11.00% ($1,935) 11.00% ($2,309)
11.20% ($967) 11.20% ($1,451) 11.20% ($1,451) 11.20% ($1,724) 11.20% ($1,965) 11.20% ($2,335)
11.40% ($983) 11.40% ($1,474) 11.40% ($1,474) 11.40% ($1,743) 11.40% ($1,996) 11.40% ($2,360)
11.60% ($998) 11.60% ($1,497) 11.60% ($1,497) 11.60% ($1,762) 11.60% ($2,027) 11.60% ($2,386)
11.80% ($1,013) 11.80% ($1,520) 11.80% ($1,520) 11.80% ($1,781) 11.80% ($2,058) 11.80% ($2,412)
12.00% ($1,029) 12.00% ($1,543) 12.00% ($1,543) 12.00% ($1,800) 12.00% ($2,090) 12.00% ($2,438)
12.20% ($1,044) 12.20% ($1,566) 12.20% ($1,566) 12.20% ($1,820) 12.20% ($2,121) 12.20% ($2,464)
12.40% ($1,060) 12.40% ($1,589) 12.40% ($1,589) 12.40% ($1,839) 12.40% ($2,152) 12.40% ($2,491)
12.60% ($1,075) 12.60% ($1,613) 12.60% ($1,613) 12.60% ($1,859) 12.60% ($2,184) 12.60% ($2,517)
12.80% ($1,091) 12.80% ($1,636) 12.80% ($1,636) 12.80% ($1,878) 12.80% ($2,216) 12.80% ($2,544)
13.00% ($1,106) 13.00% ($1,659) 13.00% ($1,659) 13.00% ($1,898) 13.00% ($2,247) 13.00% ($2,570)
13.20% ($1,122) 13.20% ($1,683) 13.20% ($1,683) 13.20% ($1,918) 13.20% ($2,279) 13.20% ($2,597)
13.40% ($1,138) 13.40% ($1,706) 13.40% ($1,706) 13.40% ($1,938) 13.40% ($2,311) 13.40% ($2,624)
13.60% ($1,153) 13.60% ($1,730) 13.60% ($1,730) 13.60% ($1,957) 13.60% ($2,343) 13.60% ($2,651)
13.80% ($1,169) 13.80% ($1,754) 13.80% ($1,754) 13.80% ($1,977) 13.80% ($2,375) 13.80% ($2,678)
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This is the upper left corner of the spread sheet.

You can also use the box on the thumbnail to 

zoom in and out of the current page.




4  Place the pointer over the handle in the lower-

right corner of the box in the thumbnail.  The

pointer changes to the resize icon.        

Hold down the mouse button and drag down and 

to the right until the box reaches the bottom of the

thumbnail.  Then release the mouse button.

This is the end of the tour. Choose Close from the 

File menu to close the tour, or click the First Page

button in the tool bar to begin the tour again. 

This is the lower right corner of the spreadsheet.  

You can drag the box shown on the thumbnail to 

scroll about a page.




3  Place the pointer over the box in the 

thumbnail.  The pointer becomes a hand.  Hold 

down the mouse button, and drag the box to 

the upper left corner of the thumbnail.  Then 

release the mouse button to see the new view.
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Now you will create a link between a person's 

name in the phone list and the corresponding 

office location.



1 Click the link tool in the tool bar; then position 

the pointer at the upper left of the name "Evans" 

and drag down and to the right to drag a box 

around the name.



The Make Link dialog box appears.



2 Now magnify the page view to 300%. Select 

the Zoom box at the bottom of the screen, and 

drag to select Other from the menu. Enter 300 

and click OK.

3 Click the find tool in the tool bar, enter the 

name "Jake," click the Match Whole Word

option and then click Find.



The first click finds the name in the phone list 

and closes the dialog box so that you can more

easily locate the highlighted text. 



Press Control + G (with Windows) and 

Command - G (on the Macintosh) to find the 

next occurence of the word.

5 You have created the link. If you wish to test

the link, click the link box once and then use the

Go Back button to return to this screen.

Then continue with the tour.



Continue . . .
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4 Click OK in the Make Link dialog box to 

create the link.
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This is an Acrobat phone list. Suppose that Albert Donnas's phone number changed and you wanted to add his new

 number to this list.



1 Click the Note button.               The mouse pointer changes to a cross hair (+).



2 Imagine the upper left corner of a note window beneath Albert Donnas's name. Place the crosshair at

 that corner, hold down the mouse button, and drag down and right to draw a box. Then release the mouse

 button.



3 Type in Albert's new number (for example 5555).



4 Click the upper left corner of the note box to close it. Then drag the note icon to the left of Albert's name.

 Double-click the note icon to reopen the note window.



� Continue . . . . .



 

There is nothing 

in the world more powerful

than an innovative idea.

Adobe Systems Incorporated

1991 Annual Report

  

This is the first page of an annual report. You will add book marks to the bookmark list that represents sections

of the annual report and then arranage the bookmarks hierarchically.



1 Choose Bookmarks from the Edit menu and New from the submenu. A new bookmark, named Untitled, is 

added to the end of the bookmark list.



2 Make sure that the bookmark is selected (highlighted) and type "Annual Report".



3 Click the Next Page button.

� 



Fiscal Year Ended

 

(In thousands, except per share data)

 

Revenue $229,653 $168,730 $121,358 $83,483 $39,324

Income before income taxes 83,598 66,291 54,853 35,750 16,892

Net income 51,607 40,070 33,706 21,080 8,982

Net income per share 2.25 1.83 1.55 .98 .43

Working capital 124,696 72,090 43,245 32,525 17,543

Total assets 221,195 145,701 94,139 65,460 32,302

Shareholders’ equity 182,750 107,800 58,825 44,297 23,525

Dividends declared per share .32 .24 .20 .12 —
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This page of the annual report shows a financial summary.



4 Choose Bookmarks from the Edit menu and New from the submenu. Name the new bookmark

"Financial Summary."



5 Choose Bookmarks from the Edit menu and Move Right from the submenu.



6 Click anywhere beneath the scroll box in the vertical scrollbar to scroll to the bottom of the page.

� 

These charts summarize the company's financial performance.



7 Choose Bookmarks from the Edit menu and New from the submenu. Type the name "Charts" for the 

new bookmark



8 Hold down the Control key (with Windows) and the Command key (on the Macintosh) and press the 

Right Arrow key. You can use the Arrow key shortcuts to move selected bookmarks up, down, left, and right.



9 Click the triangle to the left of the bookmark "Annual Report" to hide the subordinate bookmarks. Click it again

to redisplay the bookmarks.



When you have finished experimenting with bookmarks, click the page icon next to the bookmark 

"Using thumbnails" to go to the next section of the tour.
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Overview

In the last decade, personal computer users have come to depend on their ma-

chines for a variety of tasks, nearly all of which culminate in the creation of docu-

ments. These can range from one-page spreadsheets or simple letters to charts, 

graphs, illustrations and photographic images, to more complex creations, such as 

newsletters or reports, that combine all of these elements.

The computer has traditionally been a tool for building or authoring these docu-

ments, then printing them onto paper for distribution to their intended audiences. 

Despite much industry discussion of the paperless office, computers have not been 

able to effectively communicate the digital documents they create.

Much of the difficulty for computer users in sharing computer-originated documents 

stems from the mix of computing platforms, configurations and applications found 

in most of todays offices. Incompatibility between hardware platforms, operating 

systems and application software has made sharing all but the most rudimentary 

documents impossible. When it can be shared across these barriers, text must be 

exchanged only in character-based ASCII format, which robs it of any distinctive 

typefaces or formatting and precludes the use of any color or graphic elements.

Adobe Systems Incorporated, developer of software technology for creating, dis-

playing and printing digital documents, is overcoming these barriers with a new ap-

proach to document communication. The Adobe Acrobat product family allows 

users to send documents created on their computer to other computers, regardless 

of hardware platform, operating system or application software used to create the 

  

Note: If the overview pane is open, close it by 

clicking the Page Only button on the toolbar.



The Next Page button on the toolbar takes

you to the top of the next page 



1  Click the next page button.   [          ]



 

original. The document can be read, annotated, printed and stored by the receiving 

computer. Adobe Acrobat products preserve the documents essential look and 

feel, and provide tools to aid the receiver in navigating through its pages on-screen.

Adobe Acrobat products will eliminate the need to distribute many documents in 

paper form and makes possible, for the first time, effective universal electronic doc-

ument communication. Computer users can distribute fully formatted documents 

containing distinctive typefaces, color, graphics and photographs in electronic 

form. Recipients can work in one of two ways: as part of simple document distribu-

tion, in which recipients navigate, view and print documents; or document ex-

change, in which recipients navigate, view, print and annotate documents from 

others, and originate documents for transmission. This capacity for instantaneous 

communication of documents between computer users will be applicable to a 

broad range of business and consumer uses.

Adobe Acrobat Products

Adobe Acrobat software is a family of products that work together to enable docu-

ment communication. The key individual products include:

Acrobat Reader   a software application that addresses the needs of information 

consumers. It enables users to navigate, view and print documents represented in 

a special cross-platform file format, the Portable Document Format (PDF). Acrobat 

Reader software will be available for Macintosh

 



 

, Windows

 



 

, DOS and UNIX

 



 

 

platforms.

Acrobat Exchange  a software application that addresses the needs of document 

exchangers. It enables users to view, navigate, annotate and print PDF files. PDF 

Writer will be included in this product to enable the creation and transmission of 

PDF files, whether original documents or combinations of existing PDF documents. 

Acrobat Exchange software will be available for Macintosh, Windows, DOS and 

UNIX platforms.

  

The Next Page button has taken you to the top of

the next page.



The Next Page command on the view menu also

takes you to the top of the next page 



2  Choose Next Page from the View menu.



 

Acrobat PDF Writer  a specially designed printer driver that produces PDF files 

from applications. PDF Writers will come with Acrobat Exchange versions for Mac-

intosh and Windows, the environments where such a driver will be the primary 

means of producing files in the Acrobat PDF.

Acrobat Distiller
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  a software program that translates PostScript

 



 

 language files 

into PDF. Acrobat Distiller software will be available for Macintosh, Windows and 

UNIX platforms.

Following is a description of the technical components of Acrobat products and 

how they work together to enable universal document communication.

The Technology Behind Adobe Acrobat : The Portable Document Format (PDF)

The key to the cross-platform functionality of Adobe Acrobat products is a unique 

PostScript language-based file format called the Portable Document Format, or 

PDF. A PDF file can describe documents containing any combination of text, 

graphics and images in a device- and resolution-independent format. These docu-

ments can be one page or thousands of pages, very simple or extremely complex 

with rich use of fonts, graphics, color and images.

PDF, which Adobe will document and publish for use by software developers as an 

open standard, is designed to replicate the appearance of pages with the same 

high fidelity as PostScript software. But a PDF file uses the PostScript language to 

describe not only the visual (printable) aspects of a document, but also additional 

document elements such as annotations (notes), hypertext links, miniature thumb-

nail views of pages, and bookmarks. 

Like the PostScript language, PDF files are both device- and resolution-indepen-

dent. They appear on a computer display at the screens highest possible resolu-

tion, regardless of the hardware design or manufacturer. Because it is device- 

independent, PDF represents information about a pages appearance in a manner 

that can be rendered by all major computers, display screens or output devices  an 

  

The Next Page command has taken you to the top

of the next page.



The page down key pages through a document 

one screenful at a time.



3  Press the Page Down key.  (Press the Return if 

you are using a Macintosh without a 

page down key.) 

  

Page Down took you down one screenful on the 

current page.




4  Press the Page Down key again. 

  

Page Down took you to the bottom of the page.



5  Press the Page Down key again to go to the 

top of the next page. 



 

essential capability in todays world of multiplatform computing environments.

Creating PDF Files

Because the Portable Document Format is hardware platform, operating system 

and application neutral, virtually any document on any platform from any applica-

tion can be converted into a PDF file. 

A PDF file can be created from any application program that prints. The file may 

start as a word processing document, illustration from a drawing program, or a 

worksheet or graph from a spreadsheet program. Combinations of these elements 

created using cut and paste system utilities or through more advanced importation 

into page-layout applications can also readily be turned into PDF files, or can be 

clipped together in Adobe Acrobat itself. 

The conversion from the document produced by the application into a PDF file is 

accomplished in one of two ways  either by using the specially designed printer 

driver, called the Acrobat PDF Writer, or through the software translation program, 

called the Acrobat Distiller.

To produce a PDF file using the PDF Writer, the user simply proceeds as if to print 

the document. In a special print dialog, the user is presented with the option of cre-

ating a PDF file. The PDF Writers is designed to translate most files created on 

PCs running Windows and on Macintosh computers. The PDF Writer essentially 

converts GDI (for Windows) or QuickDraw
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 (for Macintosh) document descriptions 

into PDF descriptions and uses the standard system-level printing interfaces to 

communicate with applications.

Acrobat Distiller software translates PostScript language files into PDF files. It is 

designed to create PDF files from computing environments such as UNIX and 

DOS, where printer drivers do not exist. In addition, Acrobat Distiller helps users 

create PDF files from documents that contain placed Encapsulated PostScript 

(EPS) artwork or images, as well as from documents created in applications that 

  

Page Down took you to the top of the next page.



The Last Page button takes you to the 

top of the last page



6  Click the Last Page button  [          ]

or choose Last Page from the view menu. 



 

bypass system-level printing facilities and generate their own PostScript language 

files for printing. 

Small, Portable Files

The PDF is 7-bit ASCII (American Standard Code for Information Exchange), 

which means that it is extremely portable between diverse hardware and operating 

system environments. By international agreement, this standard is recognized by 

all computer hardware and software makers as a universal means of exchanging 

text information electronically.

While 7-bit ASCII formatting ensures the universality of PDF files, data compress-

sion makes them compact for speedy transmission and low demand on memory 

space. Compression algorithms such as LZW, RLE, CCITT Group 3 and 4, and 

JPEG are used to keep file sizes manageable. Compression of information within 

a PDF file will occur in the PDF Writer or Acrobat Distiller, and decompression will 

take place on the fly within Acrobat Reader or Acrobat Exchange software.

With JPEG, color and grayscale images can be compressed by a factor of 10:1 or 

more. The effective compression of monochrome images is highly dependent on 

the compression filter used and the properties of the image, but factors of 2:1 to 8:1 

are common. LZW compression of text and graphics comprising the balance of the 

document results in compression ratios of approximately 2:1.

For all but the most graphics-intensive documents, PDF files will be significantly 

smaller than the CCITT Group 3-compresssed counterparts used for facsimile. A 

200-dpi CCITT Group 3 file of 50 to 65K per page, for example, would require only 

5 to 10K per page as a PDF file, and would be capable of printing at 300-dpi or any 

other required resolution. The reduction in file size translates into shorter transmis-

sion times across networks and phone lines and less demand for memory space. 

In addition, traditional document imaging systems that represent document pages 

as Group 4 images are limited by fixed resolution, no color, no ability to search for 

content, and limited portability.



 

The universality of PDF and the effectiveness of its compression scheme allow 

PDF files to be communicated by a variety of means  over LAN networks, on CD-

ROM or magnetic diskette, or over telecommunications networks or other electron-

ic highways. Before Adobes PDF, the only universal language available for this 

type of cross-platform communication was ASCII text. PDF provides the first uni-

versal alternative to ASCII, and the only reliable means for conveying information 

about graphics and photographs between platforms.

With PDF, authors or publishers can create documents in a single format, then 

send them to computer users on many platforms. These documents can be viewed 

or printed by any computer equipped with Acrobat Reader or Acrobat Exchange 

software. This eliminates the need to publish documents in formats specific to each 

intended readers computer system. 

Acrobat Exchange Software

While Acrobat Reader enables document recipients to navigate, view and print 

pages, Acrobat Exchange software lets them view incoming PDF files, as well as 

navigate, annotate and print the documents. Its graphical interface provides clear, 

intuitive access to all of its functions. 

Acrobat Exchange includes navigational tools that can pan, scroll and zoom, and 

allow the user to access different portions of a document using miniature thumbnail 

representations of each page. The thumbnails appear in the margin of the main 

window and are visible independently from the document open on-screen. The 

user can leaf through the thumbnails as if they were bound in a magazine, then 

jump from the page on-screen to a distant page by mouse-clicking the thumbnail 

for the destination page.

Acrobat Exchange also has a live links feature that enables users to create links in 

PDF files. These are ideal for cross-referencing within a document.



 

Acrobat Exchange software even allows the reader to annotate PDF files by affix-

ing electronic sticky notes to them. These notes are transmitted along with the main 

PDF file, and may be hidden or displayed at the readers discretion.

Acrobat Exchange software includes the PDF Writer printer driver to enable docu-

ment creation and transmission. 

Acrobat Font Substitution

A key component of Adobe Acrobat software is a font substitution capability that 

solves one of the fundamental barriers to document communication,the font prob-

lem. In current systems, if a computer lacks a font in a document received, the user 

may not be able to view or print the document, or the computer may substitute a 

different font for the absent one, drastically altering the documents appearance or 

making it completely illegible.

Adobe Acrobat products use Adobes multiple master font technology to solve the 

font problem in document communication. Multiple master fonts were developed 

by Adobe as an extension to Adobes Type 1 font format. They can allow users to 

control weight, width, size and style of type across a broad adjustable range. 

PDF files carry the metrics and other information about the fonts used in a docu-

ment, without actually including the font. The PDF file contains information about 

the weight, width, size and style of the typefaces in the document, as well as the 

names of the specific fonts. When the receiver of a PDF file lacks a typeface in a 

document, Acrobat font substitution reads the metrics and simulates the absent 

fonts with a special Adobe multiple master typeface. The appearance of the un-

available font is approximated so closely that, even if the recipient has none of the 

fonts in the original document, the relative size, boldness and style of type on the 

page is retained, preserving the look and feel of text on the page.

Acrobat software uses two special multiple master fonts, a serif and a sans serif 

design, developed with a wide dynamic range to effectively simulate a vast number 



 

and variety of text typefaces.

Acrobat Publishers Tools

In the future, a set of tools for corporate and commercial publishers will provide a 

means for creating new PDF documents with a variety of enhanced functions. Pub-

lishers will use these tools to add value to PDF versions of their publications, which 

could be distributed on-line or on CD-ROM with versions of Acrobat Reader soft-

ware. The Acrobat publishers tools will enable automatic live-linked indexes for 

documents, allowing the reader to locate any passage instantly by clicking on its 

entry in the index. The tools also will accommodate popular search engine soft-

ware. It enables the user to locate any word or entry in a document instantly, or 

even cross-reference different subjects within a document or set of documents.

Another possibility is the creation of deep advertisements within electronic docu-

ments. An interested reader, for example, could click on a photo of an advertised 

product and gain access to more detailed information about it, such as perfor-

mance specifications or a list of local dealers.

In addition, Adobe Acrobat products will provide support for representing document 

structure such as standard generalized markup language (SGML), and different 

applications file structures.

Markets for Adobe Acrobat Products

The ability to send and receive fully formatted electronic documents immediately 

lends itself to two uses: personal and mass communication. To fully realize its long-

term potential, any significant document communication strategy must fulfill the re-

quirements of both markets today.

Personal Communication

Communication is a primary area of immediate use for Adobe Acrobat products. In 

this context, communication may be defined as enabling a group of computer users 

to create and send an electronic document to other members of the group, even if 



 

their computer system and applications are different.

Communication roles for Adobe Acrobat products can be characterized as server-

based or telecommunications-based. Server-based applications involve the com-

munication of computer files in PDF across networks. The technology functions 

equally well within local-area networks (LANs), like those that might link computers 

within an office, and wide-area networks (WANs), like those that might connect co-

workers across a campus of several buildings or branch offices across the country. 

Telecommunications-based document communication enables electronic docu-

ments to be sent across telephone lines by modem. This is useful for communicat-

ing information between distant offices and is also ideal for traveling executives 

who use portable computers.

For business users, documents in Adobes PDF can replace much of the paper cor-

respondence that litters office desktops. The result will be greater convenience and 

significant cost reductions. Adobe Acrobat products will cut expenses associated 

with printing and photocopying documents, conveying them from sender to recipi-

ent, and filing and tracking them for future use. It will also reduce expenses  of both 

money and time  associated with moving paper documents from centralized corpo-

rate publishing sites to their target readers. Adobe Acrobat products will allow read-

ers to print just the pages they need on their own office printers, any time and in 

any quantity they desire.

Mass Communication

Electronic publishing, which may be defined as production and distribution of doc-

uments from a single source to many readers at remote sites, can itself be divided 

into two segments: commercial and corporate or business publishers. Commercial 

publishers make their profits directly from the sale of information and advertising in 

publications such as newspapers, magazines and books. Business publishers cre-

ate and distribute documents in the course of a separate business activity. Such 

documents include procedural manuals, technical documentation or user manuals, 

annual reports and marketing studies.



 

With the Adobe Acrobat family of products, both ventures may take advantage of 

publishing media that are more cost-effective than paper, including on-line, or serv-

er-based, transmission, CD-ROM, and any use of the existing electronic highways.

On-line, or server-based, electronic publishing involves direct transmission of doc-

uments over computer networks or telecommunications channels. The publisher 

might send documents to the reader across these channels, or the reader might 

access a server and order desired documents. 

CD-ROM electronic publishing entails the use of read-only optical compact discs 

as a publishing medium. The publisher distributes these discs to readers, who view 

them using a CD-ROM drive. CD-ROM is rapidly gaining popularity as a publishing 

vehicle because it offers impressive information storage capability and permits 

very quick access to information stored anywhere on the disc.

Adobe Acrobat software offers advantages to both on-line and CD-ROM publishers 

by enabling documents to be published in a format that can be read by any com-

puter user. For the first time, networked computers on different platforms will be 

able to easily communicate files that contain graphics, photographs and complex 

layouts. Acrobat software also eliminates the need to publish different CD-ROMs 

for every target computing system.

The Emerging Document Communication Field

The field of document communication is in its infancy, and recently a number of 

products and technologies have been announced that offer some capabilities of 

document communication. Some of them will compete with the Adobe Acrobat 

product offerings, while others will be complementary to them.

Many of the emerging technologies are more limited in scope than Adobe Acrobat 

products. Some are designed for multiplatform publishing, but not communication; 

others allow two-way exchange of documents, but are limited to specific platforms 
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or applications. Adobe is committed to developing Adobe Acrobat products for uni-

versal document communication, offering full publishing and communication func-

tionality on all major platforms, operating systems and applications. 

As it evolves, document communication will mark a convergence of technical ad-

vancements in the areas of computer publishing, printing and information distribu-

tion, video and telecommunications. Because the PostScript language is already a 

standard in these areas, Adobe is well aware of their collective and individual 

needs.  This insight, as well as experience as an innovator in platform-independent 

software, places Adobe in a strong position to lead the way toward digital document 

communication of the future.

Future Technology Directions for Adobe Acrobat

As electronic document communication becomes a reality, the requirements of the 

technology and users needs will continue to grow and expand. Adobe is developing 

the next areas of advanced technologies that will be important for the extension of 

Adobe Acrobat products and the Portable Document Format. These include optical 

page recognition, the ability to communicate editable electronic documents, docu-

ment management, as well as the need to address the rapidly emerging areas of 

audio and video inclusion in digital documents.

For the last 10 years, Adobe Systems has been a pioneer in the development of 

technology for the creation, display and printing of electronic documents. Adobes 

knowledge of electronic documents and the people who use them have led the 

company to embrace document communication as the next logical step in its evo-

lution.

In the 1980s, Adobe anticipated the needs of office users with PostScript software 

technology that allowed them to create, display and print professional-quality doc-

uments. In the 1990s, with the introduction of Acrobat products, Adobe will take 

communication to the next phase of its evolution.

  

Previous page has taken you to the top of the 

previous page.



The PageUp key pages backward one screenfull

at a time.




8  Press the PageUp key.  If you are using a 

Macintosh without a PageUp key, press the Shift 

and Return keys together to page up one screenful. 



 

Adobe, the Adobe logo, Acrobat, Distiller and PostScript are trademarks of Adobe Systems Incorporated which 
may be registered in certain jurisdictions. Macintosh is a registered trademark and QuickDraw is a tradmark of 
Apple Computer, Inc. Windows is a trademark of Microsoft Corporation. UNIX is a registered trademark of 
UNIX Systems Laboratory.

Copyright 

 



 

 199293 Adobe Systems Incorporated. All rights reserved. Printed in the USA. Part Number

  

Last Page has taken you to the last page of the 

document.



The Previous Page button and command work

just like the Next Page button (and command)

except that they page backward instead of forward




7  Click the Previous Page button (or choose

Previous Page from the View menu) to go to the

top of the previous page. 


	Tour menu
	Paging 
	Scrolling
	Zooming 
	Using Links
	Adding a link
	Finding words
	Adding Notes
	Using Bookmarks
	Adding Bookmarks
	Using Thumbnails

